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CaseMap v11.1

Enhancements
11.1 Build 031

The following enhancements have been added to CaseMap version 11.1 (Build 031), released
May 27, 2015:

=I_Access to a new 'How To' Video Library has been added to the Getting Started & Help
Info tabs

CaseMap now provides access to a set of 'How To' videos on how to perform basic/common
tasks in CaseMap. These 'How To' videos are accessible from either the Getting Started or
the Help & Info tabs located on the File ribbon.

= _Display the Getting Started page after a case has been closed

When a case is closed in CaseMap, the Getting Started page now displays so that other
actions such as creating a new case or opening an existing case can be performed.

=I_Option to select the integrated research platform

CaseMap now allow users to select their research platform (Lexis.com or Lexis Advance®)
based on their user preferences.

=] Lexis Advance - Get document functionality

CaseMap now directs you to Lexis Advance® when retrieving linked research articles using
the 'Get this document' function located in the Research - Authorities spreadsheet.

=] Lexis Advance - Shepardize Citation functionality

CaseMap now directs you to Lexis Advance® when a Shepard's® report for linked research is
run using the 'Shepardize’ function located in the Research - Authorities spreadsheet.

=I Lexis Advance - Search Dockets & Documents

CaseMap now directs you to Lexis Advance® when Docket & Document searches are
performed using the 'Search Dockets & Documents' function located in both the Objects -
Persons and the Objects - Organizations spreadsheets.

=l Lexis Advance - Configure Shepard's Alerts

CaseMap now sets up Shepard's Alerts in Lexis Advance® when updates/changes are
implemented in case law linked to CaseMap.

11.0 Build 131

The following enhancements have been added to CaseMap version 11.0 (Build 131), released

© 2015 LexisNexis. All rights reserved.
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January 08, 2015:

=l New user interface

CaseMap now has a new user interface that gives you easier access to the tools you need
to perform your most commonly used tasks. As part of the user interface:

e customizable ribbons now replaces the Standard Toolbar used in earlier versions of the
application. The ribbons are located at the top of the workspace, and each ribbon (Home,
Reports, Case Tools, View) consists of tabs and/or menu items used in performing the
most commonly used spreadsheet tasks and/or functions.

Additional ribbons (Outline, Linked Authority Tools, and DocManager) are displayed when
tasks utilizing their spreadsheet's functions are in required/in use.

¢ a Quick Access Toolbar has been added which allows you to place your most commonly
used commands and spreadsheet tasks within easy reach. The Quick Access Toolbar is
located above the ribbons by default, but it can be moved below the ribbon.

¢ a new Getting Started Page which is accessed when CaseMap opens, or by clicking the
File tab once the application is in use. The Getting Started Page provides you with access
to features such as importing/exporting data, setting up a case, sending data to other
applications (e.g., LexisNexis® TimeMap®), and more.

Product help and other information (Training, Support, product updates, example cases,
etc.), to include access to other application options and features is also accessed from
the Getting Started page.

Resolved Issues
11.1 Build 031

The following resolved issue has been added to CaseMap version 11.1 (Build 031), released
May 27, 2015:

=] Lexis Research - Testimonial History Report

When a Testimony History Report is run for an Expert Witness, a web browser instance is
launched and it is now directed to the LexisNexis® Expert Research On-Demand site.

=I_Access violation error is displayed when changing row height

Access violation errors are no longer generated when adjustments are made to the height
of a row(s) in the Objects, Persons, and/or the Documents spreadsheets.

=I_The 'Send To CaseMap' feature is not functioning properly in Adobe Acrobat Reader DC

After installing Adobe® Acrobat® Reader DC software, the 'Send To CaseMap' feature now
works as expected, and warning messages are no longer generated.

= _No scroll bar is available to view the complete contents in the New Filter section of the
Advanced Filter pane

A scroll bar is now available and can be used to view the complete/hidden contents located
in the 'Filter Field/Area’ of the New Filter | Saved Filters section of the Advanced Filter pane.

© 2015 LexisNexis. All rights reserved.


http://idex.lexisnexis.com

CaseMap v11.1 7

=_The Research button on the 'All Objects’ spreadsheet displays the wrong label

When the 'All Objects' spreadsheet is selected, CaseMap now correctly displays the label
'Research’ for the research button located in the Tools group of the Home ribbon.

=_Acrobat plug-in does not install for Acrobat DC versions

The CaseMap installer now detects instances of both the Full and Reader versions of the
Acrobat DC software, and correctly installs the plug-in and DLL files to appropriate locations.

E_Unable to upgrade v3, v4, and v5.1 case files to a CaseMap 11 format

CaseMap now upgrades v3, v4, and v5.1 case files to a CaseMap 11 format, and error
messages are no longer generated when the conversion is started.

=_The New Record button does not update immediately after renaming an active Object
spreadsheet

Now when the name of an Objects spreadsheet (e.g., Other Physical Evidence) is changed,
the new name is immediately applied and displayed in all appropriate locations.

11.0 Build 135

The following resolved issue has been added to CaseMap version 11.0 (Build 135), released
April 08, 2015:

=_Cannot create a new case from a template

CaseMap now prompts/allows you to select a custom template when using the New Case
Wizard to create new cases.

Current Issues

11.1 Build 031

The following items are current issues in CaseMap version 11.1 (Build 031, released May 27,
2015:

=_Resetting the Quick Access Toolbar to the default state does work as expected after
customization

After customizing the Quick Access Toolbar with additional commands, the ability to reset the
toolbar back to its original/default state may not work as expected. To restore all the toolbars
back to their default state, exit the application and hold down the ‘Shift’ key when restarting
the application.

=_Additional white space is displayed after groups are added to the Quick Access Toolbar

© 2015 LexisNexis. All rights reserved.
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When adding a group to the Quick Access Toolbar using the right click menu for the group,
additional white space is displayed in the Quick Access Toolbar instead of the icon.

=_Ribbons group icons are not displayed after resizing the CaseMap window

When resizing the application window to a very small size, the icons for the ribbon groups are
not displayed.

E_Unable to convert e-mails to PDF

Unable to convert e-mails to PDF may appear for certain e-mails where clients have migrated
to Microsoft® Office 365.

=_The DocManager Status bar may not display the correct zoom percentage

The DocManager Status bar may not display the correct zoom percentage when returning to
100%.

11.0 Build 131

The following items are current issues in CaseMap version 11.0 (Build 131), released January
08, 2015:

E_Resetting the Quick Access Toolbar to the default state does work as expected after
customization

After customizing the Quick Access Toolbar with additional commands, the ability to reset the
toolbar back to its original/default state may not work as expected. To restore all the toolbars
back to their default state, exit the application and hold down the ‘Shift’ key when restarting
the application.

=_Additional white space is displayed after groups are added to the Quick Access Toolbar

When adding a group to the Quick Access Toolbar using the right click menu for the group,
additional white space is displayed in the Quick Access Toolbar instead of the icon.

=_Ribbons group icons are not displayed after resizing the CaseMap window

When resizing the application window to a very small size, the icons for the ribbon groups are
not displayed.

=_The new spreadsheet nhame does not immediately display after renaming an object
spreadsheet

When renaming an object spreadsheet, the new record icon label does not immediately

© 2015 LexisNexis. All rights reserved.
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display the new spreadsheet name. Selecting another spreadsheet and then returning to the
renamed spreadsheet will display the correct icon label.

=l Unable to convert e-mails to PDF

Unable to convert e-mails to PDF may appear for certain e-mails where clients have migrated
to Microsoft® Office 365.

=l The DocManager Status bar may not display the correct zoom percentage

The DocManager Status bar may not display the correct zoom percentage when returning to
100%.

Previous Version Releases

CaseMap v11.0

Enhancements
Enter topic text here.

11.0 Build 131

The following enhancements have been added to CaseMap version 11.0 (Build 131) released
January 08, 2015:

=l New user interface

CaseMap now has a new user interface that gives you easier access to the tools you need
to perform your most commonly used tasks. As part of the user interface:

e customizable ribbons now replaces the Standard Toolbar used in earlier versions of the
application. The ribbons are located at the top of the workspace, and each ribbon (Home,
Reports, Case Tools, View) consists of tabs and/or menu items used in performing the
most commonly used spreadsheet tasks and/or functions.

Additional ribbons (Outline, Linked Authority Tools, and DocManager) are displayed when
tasks utilizing their spreadsheet's functions are in required/in use.

¢ a Quick Access Toolbar has been added which allows you to place your most commonly
used commands and spreadsheet tasks within easy reach. The Quick Access Toolbar is
located above the ribbons by default, but it can be moved below the ribbon.

¢ a new Getting Started Page which is accessed when CaseMap opens, or by clicking the
File tab once the application is in use. The Getting Started Page provides you with access
to features such as importing/exporting data, setting up a case, sending data to other
applications (e.g., LexisNexis® TimeMap®), and more.

Product help and other information (Training, Support, product updates, example cases,

© 2015 LexisNexis. All rights reserved.
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etc.), to include access to other application options and features is also accessed from
the Getting Started page.

Current Issues
11.0 Build 131

The following items are current issues in CaseMap version 11.0 (Build 131) released January
08, 2015:

=_Resetting the Quick Access Toolbar to the default state does work as expected after
customization

After customizing the Quick Access Toolbar with additional commands, the ability to reset the
toolbar back to its original/default state may not work as expected. To restore all the
toolbars back to their default state, exit the application and hold down the ‘Shift’ key when

restarting the application.

=_Additional white space is displayed after groups are added to the Quick Access Toolbar

When adding a group to the Quick Access Toolbar using the right click menu for the group,
additional white space is displayed in the Quick Access Toolbar instead of the icon.

E_Ribbons group icons are not displayed after resizing the CaseMap window

When resizing the application window to a very small size, the icons for the ribbon groups
are not displayed.

=_The new spreadsheet name does not immediately display after renaming an object
spreadsheet

When renaming an object spreadsheet, the new record icon label does not immediately
display the new spreadsheet name. Selecting another spreadsheet and then returning to
the renamed spreadsheet will display the correct icon label.

E_Unable to convert e-mails to PDF

Unable to convert e-mails to PDF may appear for certain e-mails where clients have migrated
to Microsoft® Office 365.

=_The DocManager Status bar may not display the correct zoom percentage

The DocManager Status bar may not display the correct zoom percentage when returning to
100%.

© 2015 LexisNexis. All rights reserved.
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CaseMap v10.0

Enhancements

10.2 Build 265

The following enhancements have been added to CaseMap version 10.2 (Build 265) released
May 2, 2014:

= Send documents to Sanction 3.5 or later as exhibits

CaseMap now allows you to send documents to Sanction 3.5 or later as exhibits. You can
send one document at a time or send all of the document in the current spreadsheet.

10.1 Build 67

The following enhancements have been added to CaseMap version 10.1 (Build 67) released
December 4, 2012:

=|_Use the Acrobat plug-in with Acrobat 11

CaseMap's Adobe® Acrobat plug-in now supports Acrobat version 11. All of the existing
features work as they did with prior versions of Acrobat.

10.1 Build 63

The following enhancements have been added to CaseMap version 10.1 (Build 63) released
June 18, 2012:

=l Store case data using Microsoft SQL Server

Leverage the performance of a Microsoft® SQL Server® database while still taking
advantage of all of the great new features in CaseMap version 10. Coupled with an updated
version of the CaseMap Server, administrators can create and manage SQL cases, as well as
assign permissions for many of the new features.

=I_Viewing linked files in the native application instead of DocManager

© 2015 LexisNexis. All rights reserved.



12

CaseMap Release Notes

DocManager can now be configured so that files can be viewed in their native applications
rather than automatically displaying in the DocManager file viewer. To automatically view
linked files in the native application, click Tools, then click Options and then clear the Open
Linked Files in DocManager check box.

= Use the Search Link Assistant to simplify searches for object and issue names

The Search Link Assistant makes it even easier to search case data by automatically
searching for links to objects and issues with names that match the search criteria. Take
advantage of the benefits of using short names for linking without complicating your
searches.

The Search Link Assistant is enabled by default, but you can turn it off from the Tools >
Options > Searching tab if you want more precise control over what the search includes.

10.0 Build 233

The following enhancements have been added to CaseMap version 10.0 (Build 233) released
February 24, 2012:

=I_Improved performance when embedding linked files in a PDF report

CaseMap now only makes copies of linked files specifically selected to be included in the PDF
report, rather than making copies of all files available to include.

10.0 Build 227

The following enhancements have been added to CaseMap version 10.0 (Build 227) released
February 13, 2012:

=|_View linked files in the DocManager near native viewer

CaseMap is integrated with the new DocManager near native image viewer. Use
DocManager to review and annotate documents and images without having to open the
source file in its native application. Annotations can also have searchable notes that edited
later. Annotation notes display as search results findings when the notes match the search

guery.

When a search is run in CaseMap, search hits will be highlighted in DocManager allowing for
easier content review and navigation between search hits. Once content is reviewed and

© 2015 LexisNexis. All rights reserved.
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annotated, the annotations and notes are automatically saved. When printing annotated
files, there is an option for including annotations and notes when printing to PDF.

=| Benefit from OCR processing of linked files

CaseMap automatically performs OCR (optical character recognition) processing on linked
image files and PDFs so that the text content can be indexed for full-text searching.
CaseMap runs the OCR process in the background while staff continue working in the case
file. The OCR process also makes it possible to select, copy, and annotate text in
DocManager when viewing these linked files.

= Use the new Import Linked Files Wizard to bulk import files

Use the new Import Linked Files Wizard to import one or more files into a spreadsheet at
one time. CaseMap automatically creates new records for each file while linking to the source
file saved in a network folder.

Use the wizard to import a folder of files, including files saved in subfolders. The Import

Linked Files Wizard is the quickest and easiest method of populating a CaseMap case with
multiple documents at one time.

=] Send facts from Microsoft Outlook emails

Use CaseMap's Outlook plug-in to send emails from Microsoft® Outlook 2007 and 2010 to a
CaseMap v10+ case. In Outlook 2007, the Send to CaseMap features display on a CaseMap
menu as a toolbar button and as a CaseMap ribbon. In Outlook 2010, it displays as a
CaseMap ribbon. The Outlook plug-in is optional during CaseMap installation.

=| Send facts and documents from Microsoft Word

Send fact text and documents directly from Microsoft® Word 2007 and 2010 (32-bit
versions). The Send to CaseMap features display on a CaseMap ribbon within Word. The
Word plug-in is optional during CaseMap installation.

= Create custom spreadsheets

CaseMap now provides the ability to create custom sub-object spreadsheets. New custom
spreadsheets contain five default fields: Full Name, Short Name, Role In Case, Key, and #
Facts. Additional fields can be added to the new spreadsheet as needed.

When a new spreadsheet is added, it can be used just like any other CaseMap spreadsheet.

Data can be sent to it immediately using the Send to CaseMap tool. All reporting options are
also available on new spreadsheets.

= Learn about more spreadsheet features

CaseMap offers more customization options for spreadsheets than ever before, including the
ability to:

e Rename many sub-object spreadsheets to best suit organizational needs.
¢ Delete spreadsheets from the Case Shortcuts pane.

e Change the spreadsheet display order in the Case Shortcuts pane.

=I Batch print linked files

© 2015 LexisNexis. All rights reserved.
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CaseMap's DocManager add-in program includes a Batch Print Wizard that allows for printing
documents linked to object spreadsheets, research spreadsheets (Authorities and Extracts
from Authorities spreadsheets), and the Facts spreadsheet. Linked documents can be
printed to a printer, or PDF or TIFF file. The wizard provides an option for removing any
documents from the selected batch prior to printing.

If documents are annotated, the Batch Print Wizard includes an option to print to PDF with
or without annotations and notes or burn the annotation as a permanent part of the
content (without notes). The annotation color for printing annotations can be also be
modified.

The Batch Print Wizard also provides the ability to apply Bates stamps to documents
included in the printed output. Various Bates stamp settings allow for customizing the Bates
number, the stamp style, and its placement on the printed document.

Print reports with embedded files

Reports and ReportBooks can now be printed with embedded files when printing to a PDF
file. Reports with embedded links to attached files can now be shared with others who do
not have access to CaseMap or the case.

CaseMap will only embed files that are in the Linked Files field in the object spreadsheets or
the Authority and Extracts spreadsheet or Source(s) field for the Facts spreadsheet. During
the print process, large documents or confidential documents can be removed.

Once the report is printed to PDF, spreadsheet records with linked documents or files will

display a paperclip icon. Clicking the paperclip icon opens the linked document in a new
window, in its native application.

Print search results from three different report options

The new Search Results pane contains three report options for printing search results:
Search ReportBooks, Linked File Text Hits Report, and Review Linked File Hits. The latter two
reports are offered as part the of the DocManager add-in program.

Search spreadsheets, linked file content, and annotations

CaseMap now offers full-text search capabilities for spreadsheet records and linked files.
Full-text searching also includes the ability to search annotation notes, restrict searches to
select spreadsheets, and re-run recent searches. Full-text searching in CaseMap supports
many of the common search operators used to produce precise search results.

Search results display in a new Search Results navigation pane with a list of each
spreadsheet that contains field text hits or linked files with search hits. The number of
search hits returned for each spreadsheet also displays. Use the Narrow Results panel to
view only those records that contain hits for spreadsheet fields, linked file text hits, or
annotation note hits.

Selecting a spreadsheet in the Search Results navigation pane displays the records with hits
from that spreadsheet. Linked files that contain search hits display a file icon that opens the
linked file. Annotated records with notes that contain search hits display an icon in an
Annotation Note Hit column. Annotated notes can be previewed in a pop-up window when a
mouse pointer is placed over the icon.

Review general user-interface changes

e The Total Litigator pane was removed from the Navigation pane. Data from LexisNexis
online tools can still be sent to CaseMap.

© 2015 LexisNexis. All rights reserved.
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e The DocPreviewer pane was removed from the Navigation pane. DocPreviewer features
still exist in CaseMap and can be accessed using menu options.

e The Search option on the Records menu now displays "Filter". CaseMap no longer uses
“filtering” and "searching" interchangeably.

Resolved Issues
10.2 Build 266

The following resolved issue has been added to CaseMap version 10.2 (Build 266) released
September 5, 2014:

= _Backup and Restore was not available

Backup and Restore is once again available in CaseMap. The functionality is the same as
CaseMap 10.1 and earlier.

10.2 Build 265

The following resolved issue has been added to CaseMap version 10.2 (Build 265) released
May 2, 2014:

=I_Some of the links researching a person, organization, or issue did not work

CaseMap no longer includes the links that pointed to the decommissioned LexisNexis
product Total Litigator.

10.1 Build 75

The following resolved issue has been added to CaseMap version 10.1 (Build 75) released
August 9, 2013:

© 2015 LexisNexis. All rights reserved.
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=_CaseMap would not index a case after updating the linked file for 40,000 or more

records

Resolved an issue where updating the Linked File field for more than 40,000 records at once
caused the indexer to crash. Rebuilding the index did not solve the problem. The indexer will
now handle updating any number of records.

=_The E-mail to PDF Wizard did not convert some emails correctly on some systems

Resolved an issue where some of the PDF files showed parts of the email that were blacked
out as if they had been redacted. This issue only occurred on systems where the current
user registry settings for Internet Explorer (which is used in converting the emails) were
overridden to use the machine-level settings.

10.1 Build 74

The following resolved issue has been added to CaseMap version 10.1 (Build 74) released June
14, 2013:

=_CaseMap may hang when closing a case during OCR processing

Resolved an issue where CaseMap would display a status dialog box and not close the case
when attempting to close it while processing some documents for OCR. This issue only
seemed to occur with some large PDF files.

10.1 Build 69

The following resolved issue has been added to CaseMap version 10.1 (Build 69) released
March 28, 2013:

E_A delay occurred when using Acrobat 11 to open links created with the Acrobat plug-in

Resolved an issue where there was a delay of a few seconds when CaseMap tried to open a
link created using the Acrobat plug-in using Adobe Acrobat 11 or Reader 11.

=_Links created with the Acrobat plug-in would not open in Adobe Reader 11 with

Protected Mode enabled

Resolved an issue where links created with the Acrobat plug-in would not open in Adobe
Reader 11 with Protected Mode enabled. The links opened as expected with Protected

© 2015 LexisNexis. All rights reserved.
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Mode disabled, as well as in prior versions of Adobe Reader.

10.1 Build 66
The following resolved issue has been added to CaseMap version 10.1 (Build 66) released July

13, 2012:

=|_Images linked to Authorities or Extracts spreadsheets are not searchable without editing
the records

Resolved an issue where CaseMap did not automatically index the text extracted from
images linked to the Authorities or Extracts spreadsheets. CaseMap did not include these
images in the search results unless the records were edited after the OCR text had been
extracted, causing them to be re-indexed. This issue only affects the Authorities and Extracts
spreadsheets.

10.1 Build 63

The following resolved issues have been added to CaseMap version 10.1 (Build 63) released
June 18, 2012:

-] CaseMap sometimes would not launch in a terminal services environment

Resolved an issue where CaseMap would sometimes not launch due to an error when
running in a terminal services environment, such as Citrix.

=|_CaseMap DocManager displayed [Deleted Object] for documents with no Full Name and
Short Name

Resolved an issue where CaseMap DocManager incorrectly displayed the Full Name of the
spreadsheet record for a linked file when viewing that file. If the spreadsheet record had
neither a Full Name or Short Name field value, CaseMap DocManager displayed "[Deleted
Object]". It now displays "**DELETED OR NO SHORT NAME**".

=I_Send to CaseMap from a PDF downloaded from File and Serve was not working properly

Resolved an issue where Send to CaseMap from a PDF downloaded from File and Serve was
not working properly, indicating "There was a problem reading the document.”

© 2015 LexisNexis. All rights reserved.
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10.0 Build 244
The following resolved issue has been added to CaseMap version 10.0 (Build 244) released

May 2, 2012:

E_Send to Microsoft Word from CaseMap was not working properly with the CaseMap add-
in for Word loaded

Resolved an issue where the Send to Microsoft Word feature in CaseMap was not working
properly when a Word document was already open with the CaseMap add-in for Word
loaded. The send operation fails with a warning message. Disabling the CaseMap add-in
allowed sending data without a problem.

10.0 Build 241

The following resolved issues have been added to CaseMap version 10.0 (Build 241) released
April 4, 2012:

=_CaseMap would not index a file open in Microsoft Word

Resolved an issue where CaseMap would not index a linked file that was open in Microsoft
Word. CaseMap should index a file as long as it is not opened exclusively.

=_OCR was not working for some users due to a license error when processing linked files

Resolved an issue where the OCR was not working for some users due to a license error
when processing linked images. Nuance provided version 18.1 of Licensing Manager, which
corrected the issue.

10.0 Build 233

The following resolved issues have been added to CaseMap version 10.0 (Build 233) released
February 24, 2012:

=_CaseMap would not create a new case when selecting a template from a prior version
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while in the New Case Wizard

Resolved an issue where CaseMap would not create a new case when selecting a template
from a prior version while in the New Case Wizard. It displayed a message indicating there
was a problem and would not continue. This problem exists in CaseMap version 9.

=| CaseMap would not OCR PDF files that contain any text

Resolved an issue where CaseMap would not OCR a PDF that contains text, even if most of
the PDF is an image. This issue affects image PDF files that have been Bates stamped, since
the stamps are usually added as text on top of the image. The resolution is a temporary
workaround for users who only have image PDF files and is not enabled by default. Contact
CaseMap Technical Support for assistance with this issue.

10.0 Build 229

The following reported issues have been resolved in CaseMap version 10.0 (Build 229) released
February 16, 2012:

-] CaseMap could not embed .zip or .rar files in a PDF report

Resolved an issue where CaseMap could not embed a .zip or .rar file linked to a case in a
PDF report. The PDF report was not generated. CaseMap now embeds the file correctly and
generates the report.

-] CaseMap would not launch if the trial period had expired

Resolved an issue where CaseMap would not launch if the trial period has expired, and it
could not be activated because the user was unable to access the activation wizard.

10.0 Build 227

The following reported issues have been resolved in CaseMap version 10.0 (Build 227) released
February 13, 2012:

=I_DocPreviewer converted emails to PDF with a black background

Resolved an issue where HTML and RTF emails converted to PDF from DocPreviewer's Email
to PDF Wizard resulted in a black background for the email's body text on computers that
had Windows version 7 installed and the Internet Explorer version was upgraded to version
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9. This issue made it impossible to read the email's body text. A hot fix for this issue is also
available for CaseMap versions 8 and 9. Contact CaseMap Technical Support to obtain the
hot fix.

= Send to TimeMap feature did not recognize a custom date-only field

Resolved an issue where records from a spreadsheet that displayed a custom date-only field
were sent to TimeMap and CaseMap did not send the date entered in the date-only field.
The date that displayed in TimeMap was the current date. This issue only occurred with
custom date-only fields. Date and time fields did not have this problem.

-I CaseMap incorrectly adjusted the GMT time zone for Daylight Saving Time

Resolved an issue where CaseMap adjusted for Daylight Saving Time in Fact records with
dates entered that specified the Greenwich Mean Time (GMT) time zone. GMT does not
observe Daylight Saving Time.

- CaseMap crashed when the number of active monitors was changed on a multi-monitor
system

Resolved an issue where an unhandled exception error occurred and caused CaseMap to
shut down when the number of active monitors was changed on a multi-monitor system and
caused a change in some of the screen tips in CaseMap. This issue occurred when a
projector was unplugged while CaseMap was running and a mouse cursor was placed over a
spreadsheet field header to display a screen tip.

= CaseMap does not always release a case exclusive lock

Resolved an issue where a few features in CaseMap that require an exclusive lock did not
release the exclusive lock when the feature was finished being used. CaseMap features that
require an exclusive lock include: Create Replica Wizard, Auto Number Records (case tool),
Bulk Field Copy (case tool), and Bulk Field Update (case tool).

Current issues
10.1 Build 67

The following items are current issues in CaseMap version 11.1 (Build 031, released May 27,
2015:

=|_Resetting the Quick Access Toolbar to the default state does work as expected after
customization

After customizing the Quick Access Toolbar with additional commands, the ability to reset the
toolbar back to its original/default state may not work as expected. To restore all the toolbars
back to their default state, exit the application and hold down the ‘Shift’ key when restarting
the application.
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=_Additional white space is displayed after groups are added to the Quick Access Toolbar

When adding a group to the Quick Access Toolbar using the right click menu for the group,
additional white space is displayed in the Quick Access Toolbar instead of the icon.

E_Ribbons group icons are not displayed after resizing the CaseMap window

When resizing the application window to a very small size, the icons for the ribbon groups are
not displayed.

E_Unable to convert e-mails to PDF

Unable to convert e-mails to PDF may appear for certain e-mails where clients have migrated
to Microsoft® Office 365.

=_The DocManager Status bar may not display the correct zoom percentage

The DocManager Status bar may not display the correct zoom percentage when returning to
100%.

10.0 Build 227
The following items are current issues in CaseMap version 10.0 (Build 227) released February

13, 2012:

E_CaseMap DocManager Linked File Text Hits report includes a temporary file name in the
footer of each page when printed

CaseMap uses Internet Explorer to display the report, and it includes the temporary file
name for the HTML file by default. The workaround is to change the footer format text in the
Internet Explorer Page Setup dialog for the purpose of printing this report.

E_CaseMap DocManager does not support opening attachments in Outlook MSG or PDF files

When viewing an Outlook email (MSG) or PDF file in CaseMap DocManager, it is not possible
to view the attachments contained in those files. Use the Open Native feature to view the
email in Outlook or the PDF in Acrobat to access the attachments.

=_Searching for a word followed by an Object Short Name does not return any results
when the search text is enclosed in quotes

CaseMap allows entering a search with a word followed by an Object Short Name where the
search text is enclosed in quotes, but when running the search, it does not return any hits.
For example, searching for "including HawkinsP" (with the quotes) in the Hawkins example
case does not return any results. Change the search text not to include the quotes, e.g.
including HawkinsP.

E_When searching for a number, some spreadsheet hits are included because one or more
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the date fields include that number

CaseMap indexes dates as numbers also. If a date field, such as the Creation Time Stamp
field, includes the number being searched, then that spreadsheet record will be returned as
a hit. For example, the search =12 will return records with a Creation Time Stamp of
12/31/2011.

=I_CaseMap DocManager may not highlight all of the hits in a document

CaseMap DocManager may not highlight all of the hits in document when viewing documents
from the search results. The indexed text may have slightly different word breaks than
displayed in the CaseMap DocManager viewer. CaseMap may also find search hits in the
document properties, which are not visible in CaseMap DocManager.

=I_CaseMap does not search the original document properties of an image

CaseMap does not retain the properties, or metadata, of an image that must be processed
for OCR for the purpose of full-text searching. For example, CaseMap will not find search hits
in the properties of a TIFF image linked to the case. Use the Open Native feature to view the
original properties for an image.

=I_Existing annotations are not removed when changing the Linked File value for a

spreadsheet record

CaseMap does not delete the annotations that are associated with a spreadsheet record
when changing the value in the Linked File field. This behavior avoids losing annotations on
a document when changing the path to the linked file, rather than linking a different file to
the record. There is not currently a mechanism in place to determine that it is the same file in
a different location. The workaround is to clear the Linked File value and save the record.
Then link to the new file.

=I_PDF files with a password protection encryption level higher than 40-bit (RC4) are not

indexed

Some PDF files may be reported as encrypted during indexing, even though no password is
needed to open the file. This can occur because encryption is sometimes used in PDF files to
enforce restrictions on printing or extracting text from a PDF file.

PDF files can have two kinds of passwords:

1. A password that prevents any access to the file unless the user enters a password
before opening it in Adobe Reader. CaseMap cannot index files with this type of
encryption at all.

2. A password that prevents certain operations (printing, editing, etc.) only. This type of
PDF file can be opened in Adobe Reader with no need to enter a password, but other
actions may not be allow for file. CaseMap can index this type of PDF file only if the
encryption level is 40-bit (RC4). If higher-level encryption is used, then CaseMap cannot
access the text in the PDF file.

To tell what kind of encryption is used in a PDF file, open the PDF file in Adobe Reader and
click File > Document Properties, and click the Security tab.

= CaseMap DocManager may not display all of the pages in a PowerPoint presentation in

2007 or later format

CaseMap DocManager only displays the first couple of pages for some PowerPoint 2007
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format files. This problem does not occur with all PowerPoint presentations. If it does occur,
use the Open Native feature to view the presentation in PowerPoint.

=I _Highlighting the search hits in some large (700 pages or more) files may take longer
than a minute

Hit highlighting large documents in CaseMap DocManager takes a long time. This issue
seems to occur with any large PDF. The larger the file, the longer it takes to do the hit
highlighting. By default, CaseMap DocManager does not automatically hit highlight any
document with more than 30 pages, but there may be a noticeable delay when clicking the
information bar at the top of the document to display the highlighted hits.

=| CaseMap DocManager switches to the Fit Page view when opening a link to an
annotation from the search results

CaseMap DocManager zooms out to show the entire page of the document containing the
linked annotation to ensure that the annotation is visible instead of scrolling the document
without changing the zoom level.

-I CaseMap DocManager may not display text correctly in some PDF files

CaseMap DocManager may skew the text in some PDF files contains text on top of an image.
This problem does not occur with most PDF files. If it does occur, use the Open Native
feature to view the file in Adobe Acrobat or another PDF viewer.

-I CaseMap DocManager will not display some CSV files

CaseMap DocManager will not display Comma Separated Values (CSV) files containing some
special characters. These characters are shown in the Insert Symbol dialog with keystrokes
of Alt+0160 and higher. These are special symbols, such as copyright and registered
trademark, and foreign language characters that are not likely to be found in most CSV files.
If this problem occurs, use the Open Native feature to view the file in another program, or
change the file extension of the file from .csv to .txt.

=I CaseMap DocManager is very slow to open files when Lucion File Center is configured
for use with CaseMap

CaseMap DocManager is not currently compatible with Lucion File Center, which is a third-
party product intended to replace Windows Explorer for navigating files on a computer.
When using this product, it takes much longer to open even small documents in CaseMap
DocManager.

= CaseMap does not OCR PDF files that contain any text

CaseMap will not OCR a PDF that contains text, even if most of the PDF is an image. This
issue affects image PDF files that have been Bates stamped, since the stamps are usually
added as text on top of the image.

=I CaseMap cannot embed .zip or .rar files in a PDF report

CaseMap cannot embed a .zip or .rar file linked to a case in a PDF report. The PDF report is
not generated.

= CaseMap will not launch if the trial period has expired

CaseMap will not launch if the trial period has expired, and it cannot be activated because
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the user is unable to access the activation wizard. Contact CaseMap Technical support for
assistance with this issue.

-l CaseMap DocManager does not hit highlight proximity phrases correctly

CaseMap DocManager highlights occurrences of individual words in a phrase or proximity
search, in addition to the full phrase. For example, when searching for the phrase hawkins
left, all occurrences of hawkins, left, and hawkins left are highlighted, even though they are
not returned as hits in the search.

=l CaseMap DocManager displays [Deleted Object] for documents with no Full Name and
Short Name

CaseMap DocManager displays the Full Name of the spreadsheet record for a linked file
when viewing that file. If the spreadsheet record has neither a Full Name or Short Name field
value, CaseMap DocManager incorrectly displays "[Deleted Object]". Specify a Full Name for
the spreadsheet record to display a meaningful name when viewing the linked file.

- CaseMap cannot delete a spreadsheet with several thousand records on it from an
Access case

CaseMap shuts down with an error when trying to delete an Object spreadsheet with
several thousand records on it. To avoid this problem, delete all of the records from the
spreadsheet first by clicking Tools > Case Tools > Delete All Records in View. Then try
deleting the spreadsheet.

CaseMap v9.0
Enhancements

CaseMap v9.0 introduces centralized and secure remote access to cases using Microsoft® SQL
Server®. CaseMap v9.0 SQL allows speedy access to cases over a wide area network (WAN) or
local area network (LAN), or to traditional CaseMap cases on a LAN. SQL cases provide
additional security and flexibility so different users can use different sets of features they need
to work on the cases. End-users who are familiar with using CaseMap's earlier versions will not
have to learn any new features — the only thing that has changed is the flexibility of creating
some cases that may be unusually large or long-lived for the CaseMap SQL server environment.

For more information, see the CaseMap Server help system.

- Host cases on Microsoft SQL Server

Before CaseMap v9.0, CaseMap stored case information in Microsoft® Access databases.
Our LexisNexis CaseMap development staff has now customized the appearance and ease-
of-use of these files to make them uniquely CaseMap. Most users save the cases on a
shared network server for multi-user access and backup security.

CaseMap v9.0 introduces case files that can be created and stored on SQL Server, making it
easier, more robust and scalable to sort out case data and relationships. Don't worry if your
organization does not have a SQL Server. There's no need to buy one and set it up because
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CaseMap v9.0 still creates cases that can be stored locally on a regular network server.

=I Review the two types of cases

e SQL Cases — Created by a system administrator using a special CaseMap Admin
Console. Designated case staff are assigned to cases by the administrator. When SQL
cases are enabled, users have the option of opening local or SQL case files.

e Local Cases — Created by anyone running CaseMap v9.0 and saved to a designated
network folder. Case staff can be edited by anyone who's authorized to do so. Local
cases are exactly the same as previous versions of CaseMap case files.

=-I Relax with features remaining identical to CaseMap v8.5

Existing CaseMap users will recognize that the program feature are identical to those in
CaseMap v8.5. The appearance of CaseMap v9.0 is the same as CaseMap v8.5, except for
installations that have the SQL case feature switched on.

If SQL cases are enabled in CaseMap v9.0, the SQL features appear when you open
CaseMap, allowing users the option of opening a local case or SQL case.

= Employ centralized case and user administration

IT and Litigation Support Professionals asked for greater security for CaseMap cases and
CaseMap v9.0 delivers. Organizations that use CaseMap v9.0 and install the CaseMap
Server and CaseMap Admin Console are able to centrally control the creation of new SQL
cases and assigh users to cases. Administrators are able to assign specific permissions for
case staff. Permissions are assigned to a user via roles. Users will have the same set of
permissions when assigned to single or multiple SQL cases. For example, some users may
be able to enter data on a case but are not able to create or delete custom fields.

= _Enjoy improved performance

Large organizations share cases over a wide area network (WAN). The cases often grow
over time into large files. CaseMap v9.0 SQL cases provide faster performance over a WAN
and easily handle large amounts of case data — even if case staff are working in the same
case while some are located in New York and others in Los Angeles.

= Benefit from a static price

There is no additional cost for CaseMap v9.0 and the SQL components required to enable a
SQL server to host CaseMap cases. If your organization has CaseMap subscriptions that are
current, you have the option to use CaseMap v9.0 and the SQL features.

For more information, see the CaseMap Server help system.

= Contact Support and Sales with questions

For sales questions, please contact your LexisNexis CaseMap account representative at 866-
316-8525 or send email to casemap.sales@lexisnexis.com.

For technical support, please please call 877-301-0344. International users please call 904-
373-2160. Hours for live support are 9:00 AM to 6:00 PM, Eastern U.S. time. Or send an
email to casemap.support@lexisnexis.com.
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CaseMap v8.5
Enhancements

For more information on the following enhancements, reference the topics noted for the
CaseMap Answer Center.

=l Updated integration with Shepard's Citations

Automatic look-up for Shepard's signals for case law citations when a case is opened.
Shepard's signal status display for each case law citation in the Authorities spreadsheet.

For more information, see the About Shepard's Signals and Using Shepard's Signals topics.

=I_Integration with LexisNexis online content

Integration with LexisNexis online content allows you to easily perform context-specific
searches for people, organizations, issues, and case law.

For more information, see the Using online research tools topic.

=l New Case Jumpstart Wizard

CaseMap's new Case Jumpstart Wizard allows for initial data entry of a cast of characters
when a case is first created.

For more information, see the Using the Case Jumpstart Wizard topic.

CaseMap v8.0
Enhancements

For more information on the following enhancements, reference the topics noted for the
CaseMap Answer Center.

=l User interface design changes

CaseMap introduced a new user interface design that looks and feels like Microsoft®
Outlook 2007. The navigation pane displays favorite spreadsheets in the top panel for easy
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access. All spreadsheets in the case display in the All Shortcuts panel. To make a
spreadsheet a favorite, right-click on it in the All Shortcuts panel and select Add to Favorites.

For more information, see the About navigating and About the Getting Started pane topics.

=1 Friendlier spreadsheets

With the new user interface design, spreadsheets now look different too. Rows display in
alternate shades so it is easier to track information across the spreadsheet. Selected
records now display all field buttons for drop-down menus or other tool options. All records
with linked file attachments now display a Paperclip icon, even if the record is not selected.
Tool Tips are also available for each field by floating your mouse pointer over the field
header.

=l New Case Replication Wizard

A new Case Replication Wizard makes it easier to take a case replica and set of linked
documents on the road. The wizard makes it easier to put a replica and folder of linked
documents on a laptop. You also have the option of saving a replica to another location on
the network.

For more information, see the Creating replica cases topic.

=l New DocPreviewer add-in for Acrobat PDF and Outlook integration

CaseMap’s new DocPreviewer add-in program builds on the success of earlier add-ins for
PDF documents viewed using Adobe® Acrobat or Reader. Linking multiple PDFs into
CaseMap is the most popular DocPreviewer feature. With the CaseMap v8.0 PDF Review
feature you can browse through linked PDFs to extract facts with just one window open for
the documents. DocPreviewer’s premium features (additional subscription required) are
Bates Stamping PDFs, Acrobat and CaseMap Bates number recognition and importation into
appropriate Documents spreadsheet fields, and converting Microsoft® Outlook PST files to
PDFs. Importing DocPreviewer-converted emails into CaseMap optionally adds senders and
recipients to your CaseMap cast of characters, too. DocPreviewer tools are accessible as
shortcuts on the navigation pane.

For more information, see the About PDFs and DocPreviewer topic.

- Bates Stamp PDFs

Use to Bates stamp PDF files. See the Bates stamping PDFs topic.

- Convert E-mails to PDF

Use to convert emails in Microsoft® Outlook folders to PDF files that can be sent to
CaseMap. Any email attachments are embedded in the PDF file. You have the option to
populate the Persons spreadsheet with senders and recipients of the email. A wizard
helps makes this conversion process easy. CaseMap will automatically link the emails to
the senders and recipients. See the Converting emails to PDF topic.

= _Import PDFs

Use to import one or multiple PDF files in to CaseMap. Data imported includes the page
count, Bates numbering, the document's full name and short name. Body content from the
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PDF file is imported by using CaseMap's Send To utility. You must have Adobe® Acrobat
(Standard or Professional) installed on the same computer as CaseMap to use this
feature. See the Importing PDFs topic.

= Review PDFs
Use to review a set of linked PDF files in Acrobat without having to open multiple
documents and flip back and forth between the PDF file and CaseMap. Buttons in the
Acrobat toolbar allow you to move to the next or prior linked document. See the
Reviewing PDFs topic.

= _Batch Print PDFs

Use to print all linked PDF documents in a spreadsheet. See the Batch printing linked PDFs
topic.

=l Create a Privilege Log

Use to launch a Privilege Log from the DocPreviewer panel of the Navigation pane. This
CaseMap report wizard is new to the DocPreviewer pane and still accessible from the
Reports menu. See the Printing a Privilege Log topic.

=l _Analyze Bates Numbers

Use to run reports on whether there is any duplicate Bates numbering of documents or
any gaps in numbering. This tool includes an option to save current tab data as a report.
See the Analyzing Bates numbers topic.

=l Locate a Bates Range

Use to search a Bates range to locate a particular set of records, which then displays in
the Documents spreadsheet. See the Locating a Bates range topic.
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